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OPA members make

Some Oklahoma Press
Association (OPA) mem-
bers have announced, or are
looking at making changes to
single-copy and subscription
pricing.

One of these is The Carne-
gie Herald, which announced
plans to increase single-copy
purchase price of the paper to
$1 last month.

Herald Publisher Tommy
Wells said the increase was
necessary to help offset the
recent increase in printing
costs, as well as skyrocketing
gas prices.

“Like many small busi-
nesses, the newspaper has felt

the impact of the increases
in paper and fuel prices,” he
said.

The increase will not apply
to yearly subscription prices,
Wells said. Those will remain
unchanged.

Although The Lawton Con-
stitution is not among those
who have increased single-
copy pricing, publisher David
Stringer said the newspaper
has adjusted subscription
rates.

“While the increase in
newsprint played a factor,
our decision was based more
on the fact that we’ve been
underpricing our product,”

changes to pricing

Stringer said. “Local news
has value and the sooner we
quit apologizing for things
like adjusting rates, the better
we’ll be.”

Others are preparing to
make changes in the near
future.

Venius Dobson, publisher
of The County Times in Law-
ton, said they will be raising
subscription prices by $5,
starting May 1.

“The amount of increases
from the post office in just the
last five years is the main rea-
son. I just can’t absorb them
any longer. I have also not had

a subscription increase for 15
years,” Dobson said.

Dayna Robinson, who
along with her husband Bill,
own The Allen Advocate,
Holdenville News, Coal-
gate-Record-Register and
the Hughes County Tribune,
said they are not planning
to increase their pricing, but
anticipates that it will happen
sooner rather than later.

Additionally, The Hooker
Advance and Freedom Call
raised subscription rates last
fall. The Stigler News Senti-
nel increased its single-copy
price from $0.75 to $1.00 in
January.

PACER bill advances through Senate Judiciary Committee

Legislation is making its
way through the United States
Congress that would make
the Public Access to Court
Electronic Records (PACER)
service free for most users.

The PACER bill, known
as the Open Courts Act of
2021, would give users a new
version of the PACER sys-
tem within three years of the
bill becoming law. Currently,
users are required to pay 10
cents to view a page, and it is
capped at $3 for larger filings.
The bill passed through com-
mittee in December, and has
been placed on the full Senate
calendar.

Reporters, particularly
those covering the crime and
courts beat, are likely familiar
with the electronic service
that provides access to court
records.

Under the proposed legis-
lation, PACER “power users”
who spend more than $25,000
a quarter on court filings will
continue to pay fees, as will
federal agencies who use the
system, with the hope that
future operational costs for
the system will be covered by
annual agency fees and fund-
ing from Congress.

The legislation has gar-
nered bipartisan support.

“PACER was intended to
create a level playing field
for small-time litigants, small
business, civil society, jour-
nalists, and citizens who care
about transparency in govern-
ment,” said Sen. Rob Port-
man, R-OH, the bill’s main
Sponsor.

“However, with its frus-
trating interface and fees,
PACER has done the opposite.
The American people should
have easy access to the court
records of their country, and
this bipartisan, consensus leg-
islation will fix the problem
once and for all by putting in
place a free, streamlined sys-

tem with an emphasis on secu-
rity, accessibility, affordability,
and performance.”

Similarly, Sen. Ron Wyden,
D-OR, voiced his support for
the legislation.

“For far too long, unnec-
essary pay walls have kept
the American people from
freely accessing public court
records,” he said. “The Open
Courts Act will deliver a
long-overdue upgrade to
PACER, totaling a savings of
more than a hundred million
dollars a year in operating
costs. Federal courts will then
be able to remove burdensome

See PACER, Page 2
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From the President

By John Denny Montgomery
Co-Publisher, The Purcell Register « OPA President 2021-2022

I welcomed the news on April 6 that President Joe Biden signed into
law the Postal Reform Act of 2022.

First and foremost, let’s celebrate that this was a bi-partisan bill. It
passed in the House of Representatives last month 342-92 and passed in
the Senate 79-19.

Oklahoma’s own Brett Wesner, publisher of Wesner Publications, was instrumental in getting
this bill over the finish line.

Wesner is the chairman of the National Newspaper Association (NNA) Board of Directors and
has worked hard over many months to lobby on our behalf. I do believe that, collectively, the
newspaper industry will see the benefits of the bill’s passage.

Our industry has been working on this legislation for about 15 years and it’s nice to see the job
finally finished.

The new bill lifts the absurd requirement to pre-fund retiree health costs to the tune of $5 billion
per year. Whoa.

It also shifts about 40,000 postal workers onto Medicare parts B and D for their primary health
care benefit.

So, what does this mean for us?

It will hopefully mean fewer large postage cost increases for us going forward.

It’s no secret that continuous incremental postal increases cut us off at the knees. We rely on the
United States Postal Service to deliver our product in a timely manner. However, over the last sev-
eral years, we’ve all noticed that increase in price and decrease in service.

And I’m not condemning the entire United States Postal Service. There are many USPS
employees who bend over backwards to help us as newspaper people to achieve our goal of getting
the news to subscribers in a timely fashion.

I’d bet most of us have pretty good relationships with the people at our local post offices.

I’ve also found the postal folks in Oklahoma City are easy to work with and will do everything
in their power to give us the service we need.

But there’s a disconnect somewhere and I hope we can get it repaired.

The passage of the reform bill also means we can do more sampling to hopefully gain subscrib-
ers. We can now sample 50% of a newspaper’s paid within-county distribution. That’s up from
10% under the previous law.

Sampling like this has been popular in other parts of the country and to be honest, I haven’t
tried sampling in years.

It seems like a great time to give it another shot.

We appreciate Wesner and all those at NNA and throughout the industry who worked so tire-
lessly to get this legislation signed into law.

It takes all of us doing our part to help shape public policy. Thank you to all of our membership
who answer the call to help.

For those who are interested in these kinds of efforts, there is always the chance to volunteer for
the Oklahoma Press Association’s Government Relations Committee.

— JDM —

AS WE BEGIN TO ENTER THE SEVERE WEATHER SEASON, now would be a good time to

review plans for if something catastrophic were to hit your town or office.

What if your newspaper was directly hit? What if you lost power? What if your printer had any
of these same problems?

It never hurts to do a little preparation and it is sure a lot easier to think when you’re not in the
midst of a disaster.

And while you’re at it, make sure you have a list of all your office equipment. Or at least the
equipment you use regularly to get your product out.

We had an out-of-control wild fire threaten our town recently and I realized it had been a couple
years since I’d visited our asset list.

Things change in a couple years.

Kevin Perry
named chairman
of OCCC board

Kevin Perry, the presi-
dent of Perry Publishing and
Broadcasting Company, was
recently appointed chairman
of the Board of Regents for
Oklahoma City Community
College (OCCCQ).

Perry has served on the
OCCC board since 2016.

He will make history as the
first African American chair-
man. Perry also serves as the
chief operating officer and
vice-president for the National
Association of Broadcasters
Leadership Foundation.

“I am honored to serve in
this capacity. I have been part
of this distinguished board for
the last six years and am proud
of the achievements we have
accomplished for a great insti-
tution of higher education,”
Perry said.

Perry Publishing and
Broadcasting is comprised of
16 radio stations throughout
the United States and a state-
wide Oklahoma newspaper,
The Black Chronicle.

Perry is an alumnus of
Morehouse College in Atlanta.

OCCC offers an accredited
college education with asso-
ciate degrees, certifications,
non-credit classes and lead-
ership opportunities to more
than 17,000 students annually.

PACER

Continued from Page 1

pay walls and provide the
public, including research-
ers and journalists, with free
access to public court docu-
ments.”

There is an identical bill on
the House side. It was referred
to the House Judiciary Com-
mittee. Currently, there are no
Oklahoma members of Con-
gress sponsoring or co-spon-
soring either measure.



Postal Service plans to increase
postage for newspaper mailers

The U.S. Postal Service
announced its intention to
increase periodical postage
rates by 8.5% on average,
beginning July 10.

The announcement was
made April 6, disappointing
publishers who expected
passage of the Postal Service
Reform Act to moderate the
price increases.

“Our industry that worked
for more than a decade to help
USPS have received very bad
news this week,” said Brett
Wesner, National Newspaper
Association Chair and presi-
dent of Wesner Publications.

“It is hard to find good
news in a pricing release like
this, but there are some small
bright spots. One is that USPS
is finally recognizing the

value of our use of flats trays
for newspaper containers by
passing along a 3.7% increase
instead of the nearly 11% for
mailing sacks. Increases are
never welcomed, but recog-
nition that we are doing a lot
to be more efficient is some
small relief.”

Postmaster General Louis
Deloy said the reason for the
big increases was USPS’ con-
tinued need for cash.

The price increase was
announced the same day Pres-
ident Biden signed the Postal
Service Reform Act of 2022,
which took more than $50
billion of debt off the USPS
balance sheet.

“We recognize USPS is
facing inflation problems —
including fuel cost — but it

also has not only the relief
from PSRA but also $10 bil-
lion in CARES Act money,”
Wesner said. “Right now
USPS has a much stronger
cash flow than many in the
industry. The governors could
have recognized this situation
in such a perilous economy.
Unhappily, they did not. Now
we look forward to a recali-
bration of the plans to increase
rates again in January. Hope-
fully, the USPS’ new plans
for improving operations will
begin to show up by then.”
Wesner said NNA has
requested a major change in
how newspaper mail is han-
dled in mail processing, which
he hopes will be reflected in
the planned USPS January
2023 price increases.

Cindy Allen named Oklahoma sorority Woman of the Year

Cindy Allen,
editor and pub-
lisher of the Enid
News & Eagle,
was recently
CINDYALLEN 1 5nored by the
Oklahoma City Panhellen-
ic Association as the Delta
Gamma Woman of the Year.

\

.

The recognition ceremony
was held April 6 at the Okla-
homa City Golf and Country
Club and honored alumnae
women from 17 sororities on
college campuses in Oklaho-
ma.

During her journalism
career, Allen has served as an

editor or publisher at newspa-
pers in Oklahoma, Kansas and
Arkansas. She was named edi-
tor and publisher at the News
& Eagle in January 2021.

She is a 1978 graduate of
Shawnee High School and a
1982 graduate of the Universi-
ty of Oklahoma.

You've Got Questions!

+ Can | photograph minors without consent?

+ Can police deny access to records by issuing a press release?
+ Should | alter my archives when a person demands it?

+ Can | report inaccurate testimony given in open court?

+ What are the laws about liquor advertising? E
These are questions answered by the attorneys for the OPA Legal Services Plan

members in recent months. Newspapers always need timely legal advice on issues
related to newspaper publishing.

You should join OPA’S LEGAL SERVICES PLAN!

See www.0OkPress.com/LSP or contact Mark Thomas
at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today!
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Roger Thompson inducted into Okemah Hall of Fame

State Sen. Roger Thomp-
son, R-Okemabh, has been
inducted into the Okemah Hall
of Fame.

Thompson is owner of the
weekly Okemah News Leader
where his wife, Kay Thomp-
son, serves as publisher.

Surrounded by friends,
family and constituents,
Thompson was recognized
last month. The special event,
hosted by Okemah Communi-
ty Improvement Association
(CIA), recognized Thompson
for his “enthusiasm and efforts
to improve the community of
Okemah.”

Dr. Glen D. Johnson served
as Master of Ceremonies for
the event, and in his introduc-
tory speech, spoke glowingly
of Thompson and their friend-
ship of 40 years.

“His word is always his
bond,” Johnson said. “[He]
sets the bar very high for
everyone else.”

Thompson served in many
roles in the Okemah com-
munity, including president
of the Lions Club, Okemah
Chamber of Commerce and
Agriculture and the CIA. He
was instrumental in helping to
bring a paper tube company to
Okemah.

Thompson was elected to
the Oklahoma State Senate in
2014, and currently serves as
the chair of the Appropriations
and Budget committee.

During his acceptance
speech, Thompson affirmed

his love for small town Amer-
ica.

“We still have some of the
best schools in the state, some
of the best services in the
state,” he said.

Congresswoman Stephanie
Bice, state Senate President
Pro Tempore Greg Treat,
Senate Minority Leader
Kay Floyd, Oklahoma State
University President Kayse
Shrum, Adjutant General
Tommy Mancino and Mus-
cogee Nation Surgeon General
Dr. Lance Frye were among
those in attendance, along
with several other senators,
military and senate staff.

Thompson graduated from
Muskogee High School, but
moved to Okemah in 1985.
Thompson was the pastor of
the Okemah Church of Christ
for many years. During that
time, he earned a Bachelor
and Master of Arts in Theol-
ogy, and a Doctorate of The-
ology.

In addition to his pastoral
duties, Thompson helped
organize relief efforts during
Hurricane Katrina, traveling
to deliver supplies to the dev-
astated area. He started an
outreach ministry in Ukraine
called Good News Interna-
tional Foundation. Since its
inception, this ministry has
served over 3,000 orphans and
widows and has maintained
its outreach efforts to this day,
despite the Russian invasion
of Ukraine.

Dr. Glen D. Johnson (center) served as Master of Ceremonies for the
induction of Sen. Roger Thompson into the Okemah Hall of Fame. Pic-
tured are Okemah Community Improvement Association President Carl
Alls, Johnson and Thompson.

Members of Sen. Roger Thompson’s family celebrated his induction into
the Okemah Hall of Fame last month. Pictured are Graham Gallamore,
Kay Thompson, Mike Thompson, Pam Thompson, Roger Thompson,
Kevin Thompson, Racee Thompson, Alex Thompson, Jessica Thomp-
son, Lynn Thompson and Trace Thompson.

Learn the best practices for Public Notices at
okpress.com/public-notice-training

The Oklahoma Press Association offers three videos that describe and
illustrate the standards and best practices for publication of notices
along with downloadable material.




Enid News & Eagle names
Becker as sports editor

The Enid
News & Eagle
has named
Reese Becker as
sports editor.

“We are glad
to have Reese
join our team,”
said Cindy Allen, Enid News
& Eagle publisher. “He has
a lot of ideas about covering
our local schools and provid-
ing interesting sports stories
for our readers.”

Becker is a seven-year vet-
eran sports writer from Nor-
folk, Va. He covered asphalt
Late Model racing in the
Mid-Atlantic for three years
before making the transition

Reese Becker

to high school and college
sports.

Becker has covered college
football bowl games, Virginia
state championships and the
NCAA basketball tournament.

In 2022, he won third
place in the Football Writers
Association of America best
writing contest for a column
on Liberty University for
FifthQuarter.net.

He has appeared on ESPN
radio talking about Old
Dominion and high school
sports.

Becker also has a passion
for recruiting and helping
high school kids get to the
next level.

In a note to readers
published in its March 20
edition, The Oklahoman
announced a transition from
delivering Saturday print edi-
tions to providing subscribers
with access to full Saturday
e-editions and unlimited
access to its digital platform.

The newspaper added
some new features to its
e-edition, including offering
bonus national, world and
sports news and access to

The Oklahoman makes
changes to Saturday edition

more than 200 newspapers
throughout the USA TODAY
Network in cities across the
country.

Subscribers can access the
e-edition by clicking “E-edi-
tion” in the menu at the top
of the website, oklahoman.
com. The Oklahoman also
created a new, daily “enter-
tainment center” in its print
and e-editions featuring puz-
zles, advice and horoscopes
in an easy-to-read format.

OPA -BUSINESS MEMBERS

New book details life 2022 Photo ID Cards

of Watonga-born newsman

A recently released book
explores the life of Earnest
Hoberecht, an accomplished
novelist and former writer for
the Watonga Republican.

The biography titled “Asia
Ernie,” was written by Patrick
Killen, a longtime foreign
correspondent who worked
under Hoberecht for seven
years.

“It was easy to like Ernie,”
Killen writes. “Usually
cheerful with a good sense of
humor. I always thought of
him as a friend.”

Hoberecht was a
globe-trotting reporter and
bureau chief who got his jour-
nalism in Watonga. He earned
a degree in journalism from
the University of Oklahoma,
where he was voted the Out-
standing Journalism Graduate
of the Year.

After graduating from col-
lege, Hoberecht went to Pearl
Harbor as a laborer during
World War 11, but shortly

made the transition to serving
as editor of the Pearl Harbor
Bulletin, the Navy yard news-
paper. Following his service,
he spent two decades as Asia
bureau chief for United Press
International, a now-defunct
news agency that competed
with the Associated Press for
stories and scoops across the
globe.

Hoberecht’s achievements
eventually earned him induc-
tion into the Oklahoma Jour-
nalism Hall of Fame and the
Oklahoma Hall of Fame.

Hoberecht never aban-
doned his childhood home,
returning to visit throughout
his career and then moving
back for good in 1966. He
even contributed a weekly
humor column to the Watonga
Republican.

“Asia Ernie” is available
on Amazon and through
Xlibris. It’s also available
as an e-book on Kindle and
Apple devices.

available now.

Make sure you add a
photo ID press card
to your toolkit. These
press cards are
perfect for reporters,
photographers and
other staff members
at your newspaper.

Only $7 each!

2022

OKLAHOMA PRESS ASSOCIATION
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YOUR NAME
Your Newspapetr's Name
555-555-5555
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ORDER ONLINE AT

okpress.com/press-cards
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ABOVE: El Reno’s Gavin Bowdre catches some serious air time after flying
off a ramp made of snow on the north side of the Lake EI Reno dam after the
city was blanketed with several inches of the powder-type snow.

Photo by GLEN MILLER, EI Reno Tribune, February 9, 2022

LEFT: Kim Chura exults as he wins first in the heavyweight squat with a
bar-bending 655 pounds at the Chandler power-lifting meet. His coach is as
happy as he is.

Photo by BRIAN BLANSETT, The Lincoln County News, February 3, 2022

FEBRUARY 2022 WEEKLY WINNER:

BRIAN BLANSETT
The Lincoln County News

FEBRUARY 2022 DAILY, SEMI- AND TRI-WEEKLY WINNER:

GLEN MILLER
El Reno Tribune

The February 2022 contest was judged by a member of the Oklahoma Journalism Hall of Fame.

View all winning photos and contest rules at OkPress.com/OGE-Photo-Contest
Enter and Win a $100 Check from OGE ENERGY CORP.

For more information about the photo contest, visit okpress.com/oge-photo-contest

At OG&E, we do more than = 0G¥F

rHEr  €nergize a power grid.

wrm,-nr-u nitie

We honor our commitment to strengthen our communities.

We Energize Life

©2021 OGE Energy Corp.



Enid News & Eagle provides bridge between
Vance Air Force Base and Enid community

Vance Air Force Base is
a staple in the Enid com-
munity — having legacy of
helping pilot trainees and new
instructors feel connected to
the community and northwest
Oklahoma — and the Enid
News & Eagle is part of that
endeavor.

The News & Eagle pub-
lishes the Vance Airscoop, a
tabloid-sized, free publication.
The publication provides
information about Vance Air
Force Base in Enid, in par-
ticular, and the United States
Air Force in general, as well
as local coverage of events in
Northwest Oklahoma.

“We work cooperatively
with the public affairs office
at Vance to provide news and
information of interest to our
military members,” said Cindy
Allen, Enid News & Eagle
publisher.

Although the Vance
Airscoop has undergone a
number of changes through-
out the years as the news
and information industry has
evolved, the News & Eagle
has published the weekly
newspaper separately, with the

coopera- when they
tion of the WELCOMETO retire from
Vance pub- the mili-
lic affairs tary,” Allen
Ofﬁce’ fOr AIR FORCE BASE 2021-22 Said' “The
over 50 Airscoop is
years. their con-
“The nection to
Airscoop is their history
a commu- on the base
nications as well.”
bridge In addi-
between tion to the
the base weekly
and the Airscoop,
communi- the Enid
ty,” Allen News &
said. “Each Eagle part-
week, the ners with
Airscoop the Greater

provides a glimpse of what is
going on in the community.”

Each Friday, 2,000
Airscoop publications are
delivered on base. Vance
Airscoop also includes a
website, Facebook page and a
Twitter account.

“It’s amazing how many
veterans who have come
through Vance Air Force Base
eventually decide to make
Enid and Northwest Okla-
homa their permanent home

Enid Chamber of Commerce
to provide a Vance Relocation
Guide.

Allen said the guide is pub-
lished annually with updated
information from both the
public affairs office at Vance,
the Enid Chamber and other
community organizations
in Enid. The guide includes
demographic information
about Enid, important phone
numbers, health care options,
finding a home, church list-

ings, sports and fitness facili-
ties, arts and historic sites and
attractions, a restaurant listing
and much more.

Additionally, there is a list
of military discounts available
from local businesses, which
also benefits military retirees,
Allen said.

Airscoop is one of the
products the News & Eagle
recently added to its e-edition.
Also added was the News
& Eagle’s weekly Neighbor
section.

Airscoop is included in
Friday’s e-edition and The
Neighbor is included in Satur-
day’s e-edition.

The e-edition is the Enid
News & Eagle’s digital news-
paper that is available every
day to digital and Total Access
subscribers.

“We’ve been adding con-
tent to our e-editions over the
last year,” said Allen. “Our
e-editions include Parade
and Spry magazines as well
as additional content that we
don’t have room for in the
printed edition.”

Got News?

Share news about your
newspaper with other OPA
members!

If you have a new hire, sales
promotion, contest, or have
received an award or honor tell
us about it so we can put it in
The Oklahoma Publisher.

Send your news or story ideas to
Jacob McGuire,

jmcguire@okpress.com,
or call 405-499-0031

CREATE. SELL. PROFIT.

Make Sales Soar Like Magic

Improve your close ratios to 70% or more with the New IVIIAD

WIZARD

I It's a fact that spec ads help close more sales— and yet spec ads are

[

used less than 20% of the time. Now, with the real-world magic of MiAD® Wizard,
personalizing and presenting spec ads for EVERY prospect is as easy as 1-2-3!

No training. No time wasted. No more tough sells.
Go to miadwizard.com and see the magic for yourself!

service@metro-email.com

M E T RO® 800 223 . 1600 www.metrocreativeconnection.com

miadwizard.com
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Norman Transcript starts new podcast

In a new podcast released
March 30, The Norman Tran-
script is diving into questions
about female incarceration in
Oklahoma, a law that dispro-
portionately punishes women,
and the case of a local mother
held responsible for her son’s
death.

The podcast, titled “Pro-
tected,” explores the case of
Rebecca Hogue, a Norman
mother convicted of first-de-
gree murder in fall 2021 in the
abuse death of her two-year-
old son.

Despite her conviction,
prosecution and defense
both agreed that Hogue did
not kill her son — her for-
mer boyfriend, Christopher
Trent, did. But after he killed
Hogue’s son, Trent fled her
home and died by suicide.
With no one left to prosecute,
the Cleveland County District
Attorney turned to Hogue —
who had maintained she never
knew that Trent was abusing
her son or that he was danger-
ous — and charged her.

“After Rebecca’s convic-
tion in November, I could not
get her case out of my head
— I felt we had to continue
to expose the details of what
she went through and the
legal system that got us to this
point,” said Emma Keith, edi-
tor of The Norman Transcript.

“We’ve discovered through
our reporting that Rebecca’s

_Protected

PROTECTED (s+-o=)

1 THE SYSTEM THAT PUT
\ A MOTHER BEHIND BARS

WHERE TO LISTEN

Q Message }

Protected is The Norman Transcript’s new podcast that looks at
female incarceration in Oklahoma.

case is sadly not an anomaly
in Oklahoma, and that the
state uses legal power to dis-
proportionately punish and
incarcerate women in cases
of Failure to Protect. The
mothers punished under this
law are often not the abuser
and are, in some cases, being
abused themselves.”

“Protected” delves into
both Hogue’s case and the
wider issue of Failure to Pro-
tect, the Oklahoma statute that
means that even if a person
didn’t abuse a child, they can
be held responsible in the
child’s death if they knew or
reasonably should have known
about abuse.

Transcript news editor Max
Bryan and Keith look at the
unintended consequences of
Failure to Protect, the dis-
proportionate effect it has on
women and mothers, the state
of Oklahoma’s incarceration

of women and the details of
Hogue’s case and trial. The
podcast builds on significant
reporting in 2020, 2021 and
2022 by former Transcript
reporter Reese Gorman, who
covered Rebecca’s case from
charging to sentencing.

Bryan and Keith speak
with experts — an ACLU
lawyer, a scholar on female
incarceration — reporters,
advocates and more on the
way to understanding more
about Oklahoma’s criminal
justice system and its treat-
ment of women.

Interested listeners can hear
“Protected,” created by Keith
and Bryan, on Spotify, Apple
and Google Podcasts, or
at anchor.fm/thenormantran-
script. The five-part podcast
will release episodes biweek-
ly; the next episode is slated
for release April 13.

Tahlequah Daily Press
named CNHI
Newspaper of the Year

The Tahlequah Daily
Press was recently recog-
nized as the 2021 CNHI
Division III Newspaper of
the Year.

The newspaper was
recognized for its compre-
hensive reporting on the
consequences and complex-
ities of the landmark U.S.
Supreme Court decision
(McGirt vs. Oklahoma).

“I’m so proud of our
team at TDP, and we’re
honored to be named the
Newspaper of the Year in
Division III for the third
year in a row,” said TDP
executive editor Kim Poin-
dexter.

Poindexter was also
named the Division III edi-
torial writer of the year for
the second year in a row.

Other OPA members
also brought home some
hardware including D.E.
Smoot, Muskogee Phoenix,
Division II editorial writer
of the year; Chelsea Weeks,
Claremore Daily Progress,
Division III columnist of
the year; and, Chris Peters,
Michelle Charles and Beau
Simmons, all from the
Stillwater News-Press, for
digital storytelling.

SAVE THE DATE!
June 10-11, 2022

OPA CONVENTION

Sheraton OKC Downtown Hotel




OSSAA honors SWishr

Kingfisher Times & Free Press managing editor Michael
Swisher is presented a Media Excellence Award at State Fair
Arena by Oklahoma Secondary Schools Activities Association
Assistant Director David Glover. The award is in recognition
of Swisher's “many years of outstanding media coverage
at OSSAA activities. Swisher was recently recognized as
Kingfisher's Citizen of the Year by the chamber of commerce.
Christine Reid, senior editor of the Times & Free Press, said
Swisher will soon be receiving another honor. He was named
a 2022 Editor Extraordinaire by Editor & Publisher magazine.
Swisher will be profiled in E&P’s May issue.

Photo by Russell Stitt, Kingfisher Times & Free Press

Reprinted with permission

Shawnee News-Star makes
changes to Weekender edlition

The Shawnee News-Star
has made delivery changes to
its Weekender edition.

Instead of home deliveries
on Saturday morning, the
Weekender edition will be
delivered on Sunday morning.
Newspapers sold in local retail
locations will be available
Sunday morning. Changes
began with its March 26-27
edition.

Managing Editor Kim
Morava said the delivery
change is necessary at this
time to align with the avail-
ability of distribution and
news carriers who currently
deliver the News-Star.

While News-Star custom-

ers with current home carrier
delivery will get the Weekend-
er on Sunday, for some cus-
tomers who get their newspa-
pers by U.S. mail, that deliv-
ery will be in Monday’s mail
since there is no postal service
on Sundays. The Weekender
e-edition will continue to post
online at www.news-star.com
as usual on Saturday.

The News-Star, formerly
owned by Gannett, was sold
to CherryRoad Media Feb. 1.

The News-Star is in a
transition phase with new
ownership and improvement
of operations, so there will be
exciting changes coming and
announced soon, Morava said.

The importance of proofreading

BY JOHN FOUST
Proofreading is one of the
most important skills in the
advertising world. While any-
body with a sense of humor
can appreciate a harmless
blooper (one of my favorites
is the sign that read, “Ears
pierced while you wait”), no
advertiser wants to run an ad
with a mistake. Many an ad
campaign has been damaged
by typographical errors inap-
propriate illustrations and
inaccurate information.
I remember receiving an
email promoting a Zoom
meeting that seemed interest-
ing. However, the copy put a
stop to any thoughts I had of
registering. The date of the
event was listed as March 9
in the headline, and as March
2 in the body copy. To make
matters even more confusing,
the email was sent during
the first week of April. What
are the chances that anyone
made the effort to contact the
advertiser to find out the real
date? Slim and none. (And
like the old saying, Slim just
left town.)
Proofreading would have
prevented that problem.

Early in my ad agency
days, I designed a logo for a
development company. When
the printing was completed, I
enthusiastically drove to their
out-of-town office, my back-
seat loaded with boxes of let-
terheads, envelopes and busi-
ness cards. My excitement
faded as soon as my client
pointed out that one digit in
their address was incorrect;
what appeared as a 9 should
have been a 7. The only way
to handle the mistake was to
offer to reprint everything at
my expense.

Proofreading would have
prevented that costly lesson.

Then there was the half-
page furniture ad with “Store
Name Here” at the bottom.
Obviously, a manufacturer
had provided the ad to local
merchants who were sup-

posed to insert their individual
logos. In addition to being a
glaring error, that probably
cost that particular dealer
some co-op money. Proof-
reading would have prevented
that, too.

Typos can be sneaky. For
example, take a look at this

four-line headline.
DON'T MISS
OUR BIGGEST
SALE OF
OF THE YEAR

The word “of” appears
twice. Because we read at a
glance and jump to conclu-
sions in a fraction of a second,
it’s easy to miss important
details.

Proofreading shouldn’t end
with typography. Consider the
photo of the fashion model
who posed in a national ad,
wearing a baseball glove on
the wrong hand. Or what
about the photo that was
flopped so it would face in
the opposite direction? The
problem was that the subjects
ended up with t-shirts featur-
ing backwards letters.

Advertisers may have
approved each one of those
ideas. But that doesn’t mean
they happily accepted respon-
sibility for the mistakes. It
would have been better to
present them with proofing
copies that were as close to
perfect as possible.

The point of all this is sim-
ple: (1) Proofread everything
before it is published. (2) If
possible, ask someone else to
proofread it. (3) Then check
it one more time for good
measure.

Speaking of measuring,
this seems like a good time
to quote carpentry’s famous
slogan: “Measure twice, cut
once.”

© 2022 by John Foust. All rights reserved.
John Foust has conducted training
programs for thousands of newspaper
advertising professionals. Many ad
departments are using his training videos
to save time and get quick results from
in-house training. E-mail for information:
john@johnfoust.com.
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Printers to consider; Photoshop hot folders

from the road
by Wilma Newby
wnewby@okpress.com

Several OPA members have
been on the hunt for a quality
laser printer. And I think we
have found a winner.

The Brother HL-L6200DW
prints using built-in wireless,
Gigabit Ethernet networking,
or locally via USB interface.
It has a 520-sheet capacity
tray with a 12,000-page car-
tridge.

It duplexes and prints fast
— has proven to be a solid
performer at newspapers — all
for $250.

The Lexmark 4-series
black-and-white printers are
built for business workloads,
and have run for years at sev-
eral papers.

Specifically look at the
B3442dw, which prints letter
and legal for $350.

If the aim is a black-and-
white tabloid printer look at
these; they seem to start at
$6,000 new:

+  XEROX VersaLink B7100
Kyocera Taskalfa 3011i/3511i

+ Canon iR ADVANCE 4500
series

+ Ricoh MP 2555 series
+ Xanté en/press series

The Canon iR series and
Xanté printers are often used
at newspapers.

Several papers are leasing
to own these type of printers.
They typically start at $1,200
to $2,000. It is important to
get a warranty on used ones,
if possible. Keep up with the
maintenance, as a little upkeep
goes a long way with printer
longevity.

Make sure to download and
print the manual for any new
printer. Keep it with the print-
er so all employees can look
up how to use it.

If the newspaper has a
good Ethernet setup, use that
for the printer’s interface; it’s
much faster than the Wi-Fi.
Also look for printers with
Gigabit Ethernet.

Most publishers know to
look at the cost of replace-
ment cartridges.
They can run more
than the cost of the
printer so do plenty
of research.

Look for high
capacity cartridges,
as they are cheaper
in the long run.

Using a refillable
ink tank printer
like the Epson Eco-

Tank is also an option — the
ET-M2170 runs $330.

Stick with cartridge-free
refilling because it is cheaper
and easier.

Ultimately, it could save up
to 75% compared to the cost
of cartridges on other laser
printers.

PHOTOSHOP HOT FOLDERS

Adobe Photoshop has long
been able to create hot fold-
ers. These folders can auto-
matically perform different
commands, including instantly
saving photos.

I suggest having two fold-
ers: one for turning photos to
a standard horizontal image
size, and one for turning pho-
tos to standard vertical image
size. You’ll also want a hot
button Droplet for converting
to CMYK.

These folders can be run
on any computer that has Pho-
toshop.

The process to build them
is simple.

ACTIONS

AN
-77’_ p [ senios 2
v B3 horozan! New Action...
v L New Set...
v 2 verical iy

First, open a photo in the
Actions menu found under
the Window menu. Go to the
flyout button and choose New
Set. Call the first one Vertical
and click OK. From the flyout
button choose New Action,
then click the record button

Button Mode

S

€2 LEGAL ADVICE

is just one of the benefits of being a member of the Oklahoma Press
Association’s Legal Services Plan. Remove the worry of needing
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION'S

LEGAL SERVICES PLAN
1-888-815-2672 or 405-499-0020
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[ ¥ Unsharp Mask
Amount: 102%
Radius: 1 pixels
Threshold: 2

to perform the steps that are
done standard to all vertical
photos. This will not be the
final corrections, just the nor-
mal things that they all need.
Then press stop recording (the
first button at the bottom of
the palette).

In the Actions menu there
will be a folder called “verti-
cal” and under it a set called
“go” followed by the names
of the action steps.

Create a folder, label it
“vertical folder” and another
named “processed photos.”

Under the File menu > Auto-
mate > Batch window choose
the folder you just made on
the desktop (Vertical folder)
as the source folder and the

(Processed photos) folder
as the Destination folder.
As the photos come in
put all the vertical photos
in the vertical folder when
they are ready to process,
then open Photoshop and run
the batch.

Repeat the process for the
horizontal folder.

Droplets can be created as
well. They are just files that
tell Photoshop to do com-
mands when a file is pulled on
top of it.

They’re created in the same
way under the File menu >
Automate > Create Droplet.

OPA Computer Consultant Wilma
Newby’s column is brought to you
by the Oklahoma Advertising
Network (OAN). For more
information on the OAN program,
contact Oklahoma Press Service
at (405) 499-0020.



JOE WORLEY, former Tulsa

World executive editor and
one of the most revered and
respected figures in Oklaho-
ma journalism, died April 13,
2022, after a long battle with
pancreatic cancer. He was 74.

Worley, who was also a
retired lieutenant colonel for
the Oklahoma National Guard,
led the World newsroom as
executive editor for 19 years.
He retired in 2014 after 27
years overall at the World, and
45 years in journalism.

A Tennessee native, Worley
served as managing editor of

the Nashville Banner before
joining the staff at the Tulsa
World in 1987. After serving
in several editor roles, he was
named executive editor in
1995.

He was inducted into the
Oklahoma Journalism Hall of
Fame in 2007 and received
numerous awards and honors
for his leadership in the indus-
try.

Worley served as president
of the Oklahoma Press Asso-
ciation in 2004. He received
the Oklahoma Newspaper
Foundation’s Beachy Mussel-

DEATHS

man Award for Outstanding
Contribution to Journalism in
2009 and the OPA’s Milt Phil-
lips Award, the highest honor
given by the OPA, in 2015.
He had also been recognized
by the Society of Professional
Journalists, the Associated
Press and as an official Tulsa
Press Club Tulsa Media Icon.
In addition to journalism,
Worley was also well known
in the state’s military commu-
nity for his dedication to the
National Guard. He served 34
years between Tennessee and
Oklahoma units starting as a

private before moving to the
commissioned ranks with a
direct appointment to captain.
Worley was active in the
community over the years,
serving as a board member
for Mental Health Association
Oklahoma. He and his late
wife Myra also had a longtime
passion for the work of Pets
Helping People.
Worley is survived by
his wife, Lis Exon; son Bo
Worley; daughter Allison Con-
ley; two grandchildren; and
brother Paul Worley and sister
Providence Worley.

DONALD RAY BEENE, a
former Oklahoma newspaper
publisher, died March 25,
2022. He was 86.

Beene was born May 23,
1935, in Stillwater. He began
his career in the newspaper
business at the Cushing Daily

Citizen and later was pub-
lisher of the Drumright News
Derrick Journal in 1978 as
well as manager of the New
Art Prints in Cushing and
Drumright. He was also pub-
lisher for the Lake Keystone
News.

He married Donna Kautz
Niccum on June 13, 1983, in
Hot Springs, Arkansas. They
moved to Bristow and started
D&D office supply in 1984,
before retiring in 2010 and
moving back to Cushing.

Beene is survived by his

wife, Donna, of the home; one
son, David Ray Beene; one
daughter, LeaAnn Ladd of
Cushing; two stepdaughters,
Toni McEntire of Cushing,
and Teri Akins of Perkins;

10 grandchildren and 11
great-grandchildren.

CLOYCE W".EY, a former

publisher of The Tecumseh
Countywide News, died
March 30, 2022. He was 90.
Wiley was born the last
of nine children on a farm in
Osage County, Kansas. His

passion for recounting stories
led him to pursue a degree in
journalism at Kansas Univer-
sity, graduating in 1958.
Wiley met the love of his
life, Orinne, at the age of 11
when seated behind her at his
new school when the family

moved to Lyndon after leaving
the farm.

In 1978, the Wileys pur-
chased the The Countywide
News. Cloyce went on to start
a small publishing compa-
ny that put out the Quiviran
newspaper and handled the

monthly communications of
numerous companies.

Wiley is survived by his
three children, Elizabeth,
Mark and Sue, and five grand-
children.

Remembering our friends &
colleagues who died the previous year.

John Link, March 24, 2021
Larry Joe Marcy, March 17, 2021
William White, March 9, 2021

Please donate to the OKLAHOMA NEWSPAPER FOUNDATION

Donations to the Oklahoma Newspaper Foundation will support its efforts to improve the state’s newspaper industry and quality of journalism.

If you would like to make a donation, please send a check to:
OKLAHOMA NEWSPAPER FOUNDATION
3601 N. Lincoln Blvd., Oklahoma City, OK 73105-5499
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OKLAHOMA NATURAL GAS CONTEST WINNERS

CONGRATULATIONS TO THE FEBRUARY WINNERS
Column: JEFF MULLIN, Enid News & Eagle
Editorial: ZEKE LAY, Choctaw Times

FEBRUARY COLUMN WINNER
JEFF MULLIN, Enid News & Eagle

Invasion of Ukraine only 1st shot in wider war

Feb. 24, 2022. File that date away. Mark it on your cal-
endar. It was the day World War 1ll began, or at least
World War Il and a half.

It was last Thursday that Russian forces invaded the
sovereign nation of Ukraine, returning war to Europe
for the first time since May 8, 1945.

Ukraine may have fallen by now, | don’t know. As of
this writing Russian forces attacking from neighboring
Belarus had reportedly seized control of the Chernobyl
nuclear site, the location of the world’s worst nuclear
disaster and the scene of a colossal failure by the for-
mer Soviet Union.

Remember that term, the former Soviet Union.
Russian dictator Vladimir Putin someday wants to
remove the word “former.”

Ukraine is his first move toward that aim. For weeks
he built up his military forces on the borders of
Ukraine, daring the West to act, to try and stop him.
The West stood by, shook its fists and threatened eco-
nomic sanctions, some of which were imposed. Then,
when Russia finally did invade Ukraine, we shook our
fists harder and inflicted more economic sanctions.

None of which stopped the guns, the bombs and the
tanks from rolling over the soil of a sovereign nation.

Putin blustered and postured, of course, saying Russia
didn’t feel safe from the big, bad Ukranians, who were
supposedly persecuting Russian separatists in the
east of the country.

Putin’s forces staged so-called “false flag” attacks,
carrying out a car bombing in Donetsk, attempting to
blow up a chlorine tank in the separatist-held area of
Donbas, and others, then blaming the Ukranians for
all of it.

Putin also is afraid of big bad NATO gaining a foothold
in what he sees as his territory by admitting Ukraine
as a member. It is too late now. Soon there will be no
independent Ukraine.

Sound familiar? It should. On Sept. 1, 1939, troops
from Nazi Germany invaded Poland. The Nazis
claimed the Poles had been persecuting ethnic
Germans living in Poland and were conspiring with
Great Britain and France to encircle and crush
Germany. The SS even staged an attack at a German
radio station, blaming Polish forces. Thus Hitler called
his invasion a “retaliatory” campaign.

The Poles fought back, but their misery became com-

plete on Sept. 17, 1939, when forces from another
country invaded from the east. That other country?
The Soviet Union. Funny how that works out.

The Soviet Union ceased to exist on the day after
Christmas 1991, when the Soviet hammer and sickle
flag came down for the last time over the Kremlin,
replaced by the new tricolor Russian banner.

Putin wants nothing more than to see the hammer and
sickle restored to its former glory.

Putin used to be an officer with the euphemistically
named Committee for State Security, more commonly
known as the KGB. He reportedly was a relatively low
level agent but he served toward the end of his intelli-
gence career in Dresden, then part of East Germany,
observing the workings of the Stasi, the brutal East
German secret police.

Since leaving the KGB and getting involved in gov-
ernment, first as an adviser to the mayor of his native
St. Petersburg and then as deputy to the Kremlin’s
chief administrator, Putin’s rise has been meteoric. He
quickly became head of the FSB, the successor to the
KGB, and then, in 1999, was appointed prime minister.

And today he is the vozhd, a word literally meaning
leader but which has been linked to the personality cult
surrounding Joseph Stalin. Ah, there’s another disturb-
ing name from the past.

At any rate, to achieve his goal of reuniting the old
Soviet Union, Putin will have to invade and conquer
independent nations that, unlike Ukraine, are members
of NATO, countries like Estonia, Latvia and Lithuania.

And if any country attacks a NATO member nation,
the organization’s article 5 holds that an attack against
one ally is an attack against all, including the United
States. That would mean much more than sanctions,
it would mean American boots, and blood, on the
ground,

For now there isn’t much more we can do but watch
Ukraine be swallowed up by Russian forces. There
will be the normal consequences of any war — civilian
casualties, destruction, untold pain, countless refu-
gees and another blow struck against the principle of
democracy.

Keep the Ukrainian people in your prayers, and save
some for the rest of Europe, too. | fear this is only an
opening salvo in Putin’s attempt to restore his country
to its former evil imperial glory.
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Oklahoma
Natural Gas.

A Division of ONE Gas

Enter and Win a
$100 Check
from Oklahoma
Natural Gas!

The January 2022
Oklahoma Natural Gas
Column and Editorial Contest
was judged by a member of the
Oklahoma Journalism Hall of Fame.

Each month, send a tearsheet
or photocopy of your best
column and/or editorial to
Oklahoma Natural Gas
Contest, c/o OPA, 3601 N.
Lincoln Blvd., Oklahoma City,
OK 73105-5499. Entries also
may be emailed (full-page
tearsheet) to news@okpress.
com.

2. Include the author’s name,

name of publication, date
of publication and category
entered (column or editorial).

3. Only ONE editorial and/or

ONE column per writer per
month will be accepted.

4. All entries for the previous

month must be at the OPA
office by the 15th of the
current month.

5. Winning entries will be

reproduced on the OPA
website at www.OkPress.com.

Entries must have been
previously published in print.

Contest open to
all OPA member newspapers.

Although Oklahoma Natural Gas
Company selects representative
contest winners’ work for use
in this monthly ad, the views
expressed in winning columns
and editorials are those of the
writers and don’t necessarily
reflect the Company’s opinions.

CORRECTION: Last month's
column winner's newspaper
affiliation was incorrect.
BARB WALTER is with the
Kingfisher Times & Free Press.
We regret the error.



